WorkstationST* Service Instruction Guide

These instructions do not purport to cover all details or variations in equipment, nor to provide for every possible contingency to be met during installation, operation, and maintenance. The information is supplied for informational purposes only, and GE makes no warranty as to the accuracy of the information included herein. Changes, modifications, and/or improvements to equipment and specifications are made periodically and these changes may or may not be reflected herein. It is understood that GE may make changes, modifications, or improvements to the equipment referenced herein or to the document itself at any time. This document is intended for trained personnel familiar with the GE products referenced herein.

Public Information – This document contains non-sensitive information approved for public disclosure.

GE may have patents or pending patent applications covering subject matter in this document. The furnishing of this document does not provide any license whatsoever to any of these patents.

GE provides the following document and the information included therein as is and without warranty of any kind, expressed or implied, including but not limited to any implied statutory warranty of merchantability or fitness for particular purpose.

For further assistance or technical information, contact the nearest GE Sales or Service Office, or an authorized GE Sales Representative.

Revised: May 2020
Issued: June 2006


* Indicates a trademark of General Electric Company and/or its subsidiaries.
All other trademarks are the property of their respective owners.

We would appreciate your feedback about our documentation.
Please send comments or suggestions to controls.doc@ge.com
Document Updates

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Throughout the document</td>
<td>Added the Linux OS</td>
</tr>
<tr>
<td><strong>WorkstationST Features</strong></td>
<td>Added the features <strong>Control System Health</strong>, <strong>Device Manager Gateway</strong>, and <strong>EGD Configuration Server</strong></td>
</tr>
<tr>
<td><strong>WorkstationST Status Monitor</strong></td>
<td>Updated the <strong>Right-click Menu</strong> graphic and table</td>
</tr>
<tr>
<td><strong>Linux WorkstationST</strong></td>
<td>Added new chapter</td>
</tr>
</tbody>
</table>

Acronyms and Abbreviations

- EGD: Ethernet Global Data
- HMI: Human-machine Interface
- M&D: Maintenance & Diagnostic
- NTP: Network Time Protocol
- OSM: On Site Monitor
- SDI: System Data Interface
- UOSM: Universal On Site Monitor
- UPC: Universal Product Code
Safety Symbol Legend

**Warning**
Indicates a procedure or condition that, if not strictly observed, could result in personal injury or death.

**Caution**
Indicates a procedure or condition that, if not strictly observed, could result in damage to or destruction of equipment.

**Attention**
Indicates a procedure or condition that should be strictly followed to improve these applications.
Control System Warnings

To prevent personal injury or damage to equipment, follow all equipment safety procedures, Lockout Tagout (LOTO), and site safety procedures as indicated by Employee Health and Safety (EHS) guidelines.

Warning

This equipment contains a potential hazard of electric shock, burn, or death. Only personnel who are adequately trained and thoroughly familiar with the equipment and the instructions should install, operate, or maintain this equipment.

Warning

Isolation of test equipment from the equipment under test presents potential electrical hazards. If the test equipment cannot be grounded to the equipment under test, the test equipment’s case must be shielded to prevent contact by personnel. To minimize hazard of electrical shock or burn, approved grounding practices and procedures must be strictly followed.

Warning

To prevent personal injury or equipment damage caused by equipment malfunction, only adequately trained personnel should modify any programmable machine.

Warning

Always ensure that applicable standards and regulations are followed and only properly certified equipment is used as a critical component of a safety system. Never assume that the Human-machine Interface (HMI) nor the operator will close a safety critical control loop.
# Contents

1 Introduction ........................................................................................................... 6

2 WorkstationST Features ...................................................................................... 6
   2.1 Alarms ............................................................................................................. 6
   2.2 Live Values .................................................................................................... 7
   2.3 Historians ....................................................................................................... 7
   2.4 Network Time Protocol (Time Synchronization System) ............................... 7
   2.5 Network Status Monitor ................................................................................. 8
   2.6 On Site Monitor (OSM) .................................................................................. 8
   2.7 HMI Configuration ......................................................................................... 8
   2.8 Control System Health .................................................................................... 8
   2.9 Device Manager Gateway .............................................................................. 8
   2.10 EGD Configuration Server .......................................................................... 8

3 WorkstationST Configuration and Monitoring ...................................................... 9

4 Start and Stop WorkstationST Service ................................................................. 9
   Configuration Files Data Flow ............................................................................ 10

5 Binding EGD Data ............................................................................................... 11

6 WorkstationST Status Monitor ......................................................................... 11
   7.1 Multi-language Support .................................................................................. 12
   7.2 File Menu ...................................................................................................... 12
   7.3 Tools Menu .................................................................................................... 13
   7.4 Options Menu ................................................................................................ 23
   7.5 Start and Stop WorkstationST Features ......................................................... 23
   7.6 Status Monitor Shortcut Menu ...................................................................... 24
   7.7 Right-click Menu .......................................................................................... 31

8 On Site Monitor .................................................................................................. 32

9 Linux WorkstationST .......................................................................................... 33
   9.1 Installation ....................................................................................................... 33
   9.2 Directories ...................................................................................................... 33
   9.3 Application Settings ....................................................................................... 34
   9.4 OPC UA Certificates ...................................................................................... 34
   9.5 NTP Setup Instructions .................................................................................. 34
   9.6 WorkstationST Linux Command Line Status ............................................... 35

10 Glossary of Terms .............................................................................................. 36
1 Introduction

The WorkstationST* Service provides an interface for downloading the ToolboxST* configuration to a workstation, and ensures that configured WorkstationST Features start and stop accordingly. It also provides access to control and diagnostic information for the WorkstationST Features, access to historical Alarm and historical data, and in the case of the WorkstationST configured as Master, access to diagnostic help, message translation, HMI Screen files and Alarm sound files.

The WorkstationST service is a Windows Service when installed in the Windows OS, and a Linux Daemon when installed in the Linux OS. WorkstationST runs on the Windows operating system with a sub-set of features also running on Linux. The description of features below denotes which features are available in Linux.

2 WorkstationST Features

WorkstationST features include:

• Alarms
• Live data values
• Historians
• Network Time Protocol (NTP)
• Network Status Monitor
• On Site Monitor (OSM)
• HMI configuration tools
• Control System Health
• Device Manager Gateway
• EGD Configuration Server

2.1 Alarms

**Alarm Server** monitors and optionally historically logs alarms (process alarms, events, holds) from controllers (Mark* V1e, Mark V1eS, Mark Ve or Mark VI). It also monitors diagnostic events from controllers and Mark V1e I/O packs. Optionally, the alarm server can be configured to consume alarms from external OPC® AE and UA servers to allow third-party alarm content into our system. Remote WorkstationST alarm servers can also be consumed to allow bridging of alarms for systems that have separate unit data highways. The alarm server is supported in Linux with the exception of the OPC AE alarm consumption feature.

**OPC AE Server** provides access to external OPC AE clients to view the alarms and events that are available in the Alarm Server feature.

**Alarm Viewer** is a client to the Alarm Server to provide access to live alarms and events, and access to the optional historical log of alarms and events. The viewer has built in filtering and statistical analysis in the form of pareto charts and transition and frequency summary tabular views.

---

**Note** For more information, refer to the following documents:

- **WorkstationST Alarm Server Instruction Guide** (GEI-100626)
- **WorkstationST OPC AE Server Instruction Guide** (GEI-100624)
- **WorkstationST Alarm Viewer Instruction Guide** (GEI-100620)
2.2 Live Values

**OPC DA Server** provides access to external OPC DA clients for live data values. The CIMPLICITY* viewer is configured as an OPC client to this server to provide live data to CIMPLICITY screens. OSI® PI is configured with an OPC DA client to store live data with the historian feature (WorkstationST V03.02 and later). Proficy Historian is also configured with an OPC DA client to store live data with the historian feature (but it uses the WorkstationST V04.00 and later). The OPC DA server has an optional OPC DA client that can provide live data access to external OPC DA servers. For more information, refer to the *WorkstationST OPC DA Server Instruction Guide* (GEI-100621) and the *WorkstationST CIMPLICITY Advanced Viewer Integration Instruction Guide* (GEI-100697).

**OPC UA Server** provides access to external OPC UA clients for live data values. Additionally it provides access to historical data in the local Historian and Recorder from configured OPC HDA Historians. The OPC UA server has an optional OPC UA client that can provide live data access from external OPC UA servers. Refer to the *WorkstationST OPC UA Server Instruction Guide* (GEI-100828). The OPC UA server is available in Linux.

**Modbus** (V03.02 and later) with serial and Ethernet connections and both Master and Slave is provided. Refer to the *WorkstationST Modbus Instruction Guide* (GEI-100696). The Modbus feature is available in Linux.

The WorkstationST computer can be configured to produce EGD exchanges. EGD variables are currently from three sources:

- External OPC DA server variables accessed from the WorkstationST OPC DA server’s OPC DA client feature
- WorkstationST owned OPC DA variables driven by any external OPC DA client
- Modbus variables from external masters or slaves

2.3 Historians

**Recorder** provides access to live collections at up to frame rate periods. Variables can be configured in the ToolboxST application to be collected by the Recorder. The Recorder is available in Linux.

The following data can be automatically uploaded to files that can be viewed using the Trender:

- Trip logs
- Capture blocks in controller logic and Dynamic Data Recorder (DDR)
- Triggerable collections in the controller

**Historian** configures the target historian (OSI PI or Proficy*) to collect data from the OPC DA server. For OSI PI or Proficy historians, the WorkstationST component provides access through OPC HDA to the Trender to view the history of collected variables.

**Note** For further information, refer to the following documents:

- *WorkstationST Recorder Instruction Guide* (GEI-100627)
- *Trender for the ToolboxST Application Instruction Guide* (GEI-100795)
- *WorkstationST Historian Instruction Guide* (GEI-100628)

2.4 Network Time Protocol (Time Synchronization System)

Network Time Protocol (NTP) can be configured to serve NTP to the control system. It can be configured to use a network time card or follow an external black box network time server. Configuration for syncing to a site time source is available. For further details, refer to the *ControlST Software Suite How-to Guides* (GEH-6808), the chapter *How To Configure Time Synchronization in the ToolboxST Application*. 

**Instruction Guide**

GEI-100623N 7

**Public Information**
2.5 **Network Status Monitor**

Network Status Monitor is a feature that can be configured by the ToolboxST application to monitor managed switches on the UDH or PDH network and provide status information in the system overview. Each device is monitored through Internet Control Message Protocol (ICMP) ping, in addition to the status of each port of each managed switch. Alarms are generated and available to live and historical clients of the Alarm Server.

2.6 **On Site Monitor (OSM)**

OSM provides access to the OSM to Mark Vle/Mark Ve control's live unpublished data.

2.7 **HMI Configuration**

WorkstationST V03.02 and earlier provides an importer to synchronize a CIMPLICITY project’s point configuration database, measurement systems, resources, alarm classes, and alarm points with the ToolboxST configuration. This feature is also available in the WorkstationST application V03.03 and later, but is not the preferred method for getting CimView screens to display live data and view alarms.

WorkstationST V03.03 and later, in conjunction with the CIMPLICITY V7.5 or later, provides an OPC client feature of CimView that allows the CimView screens to access live data and variable configuration information directly from the WorkstationST application’s OPC DA server. In addition, the WorkstationST application provides CimView screens with added right-click features for adding variables to trends, viewing variable live values, and configuration. This includes the ability to view and interact with alarms on a CimView screen and some drag-and-drop access to the CimEdit application. This allows ToolboxST logic to be linked with CimEdit graphic symbols, so that dragging objects from the ToolboxST controller logic editor onto CimEdit screens (for example, dragging of a motor operated value from logic to a CimEdit screen) can result in a working, linked graphic symbol.

2.8 **Control System Health**

The Control System Health feature monitors controller and computer health, Network Health, Time Synchronization (NTP), Control server virtualization information and WorkstationST process health. The Control System Health viewer communicates using OPC UA and the ControlST alarm protocol to provide current status information. Intrinsic health status variables can also be mapped to EGD for use by EGD consumers or on CIMPLICITY screens. There is typically a single WorkstationST in a control system with this feature enabled.

2.9 **Device Manager Gateway**

The Device Manager Gateway feature enables communication between the asset management system and fieldbus devices. The gateway handles FOUNDATION Fieldbus™, HART®, and PROFIBUS® devices.

*Note* The Device Manager Gateway is not available in Linux.

2.10 **EGD Configuration Server**

The EGD configuration server provides access for reading and writing configuration information for ToolboxST. It allows ToolboxST users to publish EGD configuration for components they are configuring, allowing use of this information in other components by other users or also by other components opened by the same user. WorkstationST also uses the system level configuration information, but obtains component configuration directly from the downloaded components. The configuration in the configuration server can be different from the actual running configuration. This feature is enabled on a single WorkstationST in a system. The EGD configuration server can be enabled to run in Linux.

*Note* For configuration data flow, refer to the section *Configuration Files Data Flow.*
3  **WorkstationST Configuration and Monitoring**

System Data Interface (SDI) Command and Live Data Connections are used by the WorkstationST Service. The WorkstationST Service responds to requests for control, status, download and file upload through the SDI command connection. When the ToolboxST application connects to the WorkstationST runtime software, it uses this SDI command connection to obtain WorkstationST feature status, as well as the SDI live data connection (made to the OPC server). Live data for the historical system (Recorder) and for the alarm system (Alarm Server) are obtained through this SDI connection.

The live data connection obtains the current live data values of a WorkstationST-monitored variable. The OPC DA or OPC UA feature must be enabled to obtain live values.

4  **Start and Stop WorkstationST Service**

When the WorkstationST Service is started, the configuration is read from the folder containing the last WorkstationST configuration. The configuration includes a list of external devices that communicate with this workstation through Ethernet Global Data (EGD).

When the configuration is downloaded, an internal WorkstationST message is sent to all configured WorkstationST Features notifying them of the download. When the download is complete another message is sent. An EGD consumed data file is built by binding the EGD data obtained from the EGD Configuration Server (or from the actual device if the device is Class 3, and online).

When the WorkstationST Service is stopped, all configured WorkstationST Features are also stopped.

---

**Note**  Since the WorkstationST Service is the main communication portal to ToolboxST features, the ToolboxST application can only restart it from a remote computer, if the remote computer has service start/stop remote access authorization.
5 Configuration Files Data Flow

The WorkstationST service receives downloads of WorkstationST configuration from ToolboxST. The configuration is stored to the local configuration where it is available for use by WorkstaionST features. Other device configuration is described below.

** Each feature reads other device EGD configuration from the following sources:
- Other Device is EGD Class 2 or lower:
  - EGD Configuration Server
  - Local Cache
- Other Device is EGD Class 3 or higher:
  - Directly from the device
  - EGD Configuration Server
  - Local Cache

WorkstationST Configuration Files Data Flow
6 Binding EGD Data

The WorkstationST Service binds the EGD configuration as part of the download. The download from the ToolboxST application includes a bound EGD consumed-data file, but the WorkstationST Service attempts to rebind the configuration. By doing this, if the ToolboxST application has a stale configuration for any EGD device, the freshest configuration is used.

In addition to a ToolboxST download, the OPC server can request a configuration update if it sees an exchange signature change from a component. Mark VIe and Power Conversion components map their application revision onto an EGD exchange. These revisions are compared against the previous revision, and found in a configuration extension in the EGD Symbol table. A difference in this revision triggers the OPC server to request new configuration data from the WorkstationST application.

7 WorkstationST Status Monitor

The WorkstationST Status Monitor provides status and control of the WorkstationST features on the local computer. The Status Monitor is included in the Status tab in the Component Info View of the configured WorkstationST component.

The WorkstationST Status Monitor is configured to start when you log on to Windows®, and then runs as a tray icon. When a warning or error occurs with the WorkstationST Service or any configured feature, the appropriate icon displays.

➢➢ To monitor and configure WorkstationST features: from the taskbar notification area, double-click the Status Monitor icon.

![WorkstationST Status Monitor Feature Status](image)

---

**WorkstationST Status Monitor Feature Status**

- **WorkstationST Service**: OK, All configured features are installed and running
- **Alarm Server**: OK, Alarm Server is running with no errors
- **EGD Configuration Server**: OK, Feature is running
- **OPC DA Server**: OK, OPC DA Server is Running
- **Recorder**: OK, Recorder is Running 12 collections with 0 errors and 0 warnings. For more information View Additional Status Detail
- **Time Synchronization System**: OK, NTP Pool is synchronized

---

*Instruction Guide GEI-100623N 11*

*Public Information*
7.1 Multi-language Support

Beginning with the ControlST* V04.03, the Status Monitor can be displayed in the local Windows language.

Prior to enabling this feature, the following prerequisites apply:

- Windows Language Pack must be installed or the operating system is in the native language
- Status Monitor resource DLLs that match the selected Windows display language must be installed

Resource DLLs can be created or modified using the Resource Translation Manager utility and exporting the strings to a dictionary text file for translation. This application is automatically installed when the Configuration Tools Package or WorkstationST application is installed. The Resource Translation Manager utility can be found in the Resource Translation Manager folder, which is located within the GE Energy install folder (default install location is C:\Program Files (x86)\GE Energy\Resource Translation Manager). For instructions to create resource DLLs, refer to the Resource Translation Manager User Guide (GEI-100793).

---

**Note** The Status Monitor does not support languages that read right-to-left.

➢➢➢

To display the Status Monitor in the local Windows language

1. From the Start menu, select Control Panel and Region and Language.
2. From the Region and Language dialog box Display Language tab, select Keyboards and Languages.
3. Select a language.

---

**Note** For further details, refer to the ControlST Software Suite How-to Guides (GEH-6808), the chapter How to configure a Second Language for ControlST HMI Applications.

7.2 File Menu

The File menu allows the user to open the local folder where the WorkstationST log files are stored. It also provides the option to Save and Zip all feature logs.
7.3  Tools Menu

The Tools menu provides the following options:

- **Time Convert Utility**
- **View Registered OPC Servers**
- **Certificate Manager**
- **View EGD Configuration Differences**
- **System Workstation Consumed Device Information**
- **View System IP Address Information**

### 7.3.1 Time Convert Utility

The *Time Convert Utility* menu option converts configuration times from EGD .xml files to actual dates and times. It also converts numeric values to Universal Time Coordinated (UTC) dates and times. Unsigned integer seconds since 1970 are converted to a date and time, then converted back to seconds since 1970.

➢➢ **To convert configuration values to dates and times**: from the Tools menu, select *Time Convert Utility*.

Enter the information to be converted and press Enter.

The conversion displays to the right.

### 7.3.2 View Registered OPC Servers

The *View registered OPC Servers* menu option allows the user to view all OPC UA, OPC DA and OPC AE servers that are registered on the computer.

➢➢ **To view registered OPC servers**: from the Tools menu, select *View registered OPC servers*.

The *List of registered OPC Servers from host localhost* window displays the registered servers.
7.3.3 Certificate Manager

The Certificate Manager menu option, which requires Administrator privileges, manages the security certificates in the Windows LocalMachine\UA Applications store. The certificates are required by the OPC UA server and the client to create secure connections to other servers and clients. For details on the connection sequence between an OPC UA server and the client, refer to the WorkstationST OPC UA Server Instruction Guide (GEI-100828).

➢ To reissue a certificate: from the Tools menu, select Certificate Manager.

Select a certificate from the list (such as UA Local Discovery Server) and from the toolbar, click Reissue.

Enter the new lifetime of the certificate and click OK.
➢ To import or export a certificate
1. From the WorkstationST Certificate Manager dialog box, select the certificate.
2. From the toolbar, click **Import** or **Export**.
3. If Import is select, you are prompted to add the certificate to the computer’s trust list.
   - Click **Yes** to accept the certificate.

➢➢

➢➢

➢ To delete a certificate: from the WorkstationST Certificate Manager dialog box, select the certificate, then click **Delete** on the toolbar.

➢➢

➢➢

➢ To assign a certificate to an application: from the WorkstationST Certificate Manager dialog box, select the certificate, then click **Assign** on the toolbar.

   From the Application dropdown list, select **GeCssOpcUaServer** or **GeCssOpcUaClient**.

---

**Note** This certificate is used when the assigned OPC UA server or client makes a secure connection.
7.3.4 View EGD Configuration Differences

The View EGD Configuration Differences menu option displays the differences between the local EGD configuration files (WorkstationST cache) and the EGD Configuration Server files. The local cache remains equal to all running component configurations. It is updated once controllers are downloaded.

➢ To view EGD configuration differences: from the Tools menu, select View EGD Configuration Differences.

The Local Configuration (Local WorkstationST Cache) Compare to Server Configuration window display the comparison results between the local WorkstationST EGD configuration files and the files that were last published to EGD Configuration Server.

EGD Configuration Differences

EGD Configuration Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Local Document</td>
<td>Views the local version of a selected document</td>
</tr>
<tr>
<td>View Server Document</td>
<td>Views the server version of a selected document</td>
</tr>
<tr>
<td>Refresh Display</td>
<td>Compares the local system to the EGD configuration server and updates the display</td>
</tr>
</tbody>
</table>
7.3.5 System Workstation Consumed Device Information

The System Workstation Consumed Device Information menu option provides a report of live data consumption and alarm consumption viewed by WorkstationST, consumed devices, or as text.

➢➢ To create a Workstation Consumed Device Information report: from the Tools menu, select Workstation Consumed Device Information.

There are several tabs available for the user to view consumption. These report views are detailed in the following sections:

- Live Data Consumption
- Alarm Consumption
- View by Consumed Devices
- View as Text

Live Data Consumption View

When a Workstation Consumed Device Information report is generated, the Live Data Consumption tab (the default view) displays the direct consumption over EGD and the proxy consumption through another workstation for various controllers in a control system. In the example illustrated in the following figure, the Alarm_Primary workstation consumes the BOP controller directly, G1 and G2 through HMI_Block1, and G3 and G4 through HMI_Block2.

Live Data Consumption View
Alarm Consumption

The Alarm Consumption tab displays the direct alarm consumption for controllers on the local UDH, as well as the remote alarm consumption through other workstations. In the example illustrated in the following figure, BOP alarms are consumed directly by Alarm_Primary, G1 and G2 alarms are consumed through HMI_Block1 as a primary connection and through HMI_Block1b as a secondary connection. Likewise, alarms for G3 and G4 are consumed by HMI_Block2 primary and HMI_Block2b secondary.
**View by Consumed Devices**

The **View by Consumed Devices** tab displays the controller devices with child nodes indicating their consumers. In the example illustrated in the following figure, if the user selects the **Live Data Consumption** tab, G1 is shown consumed by HMI_Block1 and HMI_Block1b, and additionally consumed indirectly through HMI_Block1 by Alarm_Primary, Alarm_Secondary, and HMI_Block2.

If the user selects the **Alarm Consumption** tab from this view, G1 is shown as being consumed by HMI_Block1, and HMI_Block1b, and indirectly through HMI_Block1 by Alarm_Primary and Alarm_Secondary, and through HMI_Block2 by Alarm_Primary and Alarm_Secondary.
The **View as Text** tab displays a text representation of the consumption configuration, as illustrated in the following figure.
7.3.6 View System IP Address Information

The System IP Address Information report provides a report of WorkstationST device names, host name, network name, and IP address.

➢ To create a System IP Address Information report: from the View menu, select Reports, then select System IP Address Information to display the report.

<table>
<thead>
<tr>
<th>Name</th>
<th>Network Name</th>
<th>Address</th>
<th>Host Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>FTA_G1</td>
<td>UDH</td>
<td>172.20.101.67</td>
<td>FTA_G1-R</td>
</tr>
<tr>
<td>FTA_E1</td>
<td>UDH</td>
<td>172.20.101.68</td>
<td>FTA_E1</td>
</tr>
<tr>
<td>PC1</td>
<td>WITG001.1oNet</td>
<td>192.168.3.101</td>
<td>PC1</td>
</tr>
<tr>
<td>Micr1</td>
<td>UDH</td>
<td>172.20.101.73</td>
<td>Micr1-R</td>
</tr>
<tr>
<td>CCU</td>
<td>UDH</td>
<td>172.20.99.7</td>
<td>CCU-R</td>
</tr>
<tr>
<td>G8</td>
<td>UDH</td>
<td>172.20.98.8</td>
<td>G8-R</td>
</tr>
<tr>
<td>GB</td>
<td>UDH</td>
<td>172.20.96.9</td>
<td>GB-S</td>
</tr>
<tr>
<td>GB</td>
<td>UDH</td>
<td>172.20.96.10</td>
<td>GB-T</td>
</tr>
<tr>
<td>TMRM6E</td>
<td>UDH</td>
<td>172.20.102.28</td>
<td>TMRM6E-R</td>
</tr>
<tr>
<td>TMRM6E</td>
<td>UDH</td>
<td>172.20.102.29</td>
<td>TMRM6E-S</td>
</tr>
<tr>
<td>TMRM6E</td>
<td>UDH</td>
<td>172.20.102.20</td>
<td>TMRM6E-T</td>
</tr>
<tr>
<td>Mc19056</td>
<td>UDH</td>
<td>172.20.99.5</td>
<td>Mc19056-R</td>
</tr>
<tr>
<td>TW1</td>
<td>UDH</td>
<td>172.20.102.100</td>
<td>TW1-R</td>
</tr>
<tr>
<td>DiffSub</td>
<td>Other</td>
<td>172.19.1.1</td>
<td>DiffSub-R</td>
</tr>
<tr>
<td>S8</td>
<td>UDH</td>
<td>172.20.96.10</td>
<td>S8-R</td>
</tr>
<tr>
<td>S8</td>
<td>UDH</td>
<td>172.20.96.11</td>
<td>S8-S</td>
</tr>
<tr>
<td>S8</td>
<td>UDH</td>
<td>172.20.96.12</td>
<td>S8-T</td>
</tr>
<tr>
<td>G1-Ucsl_B07</td>
<td>UDH</td>
<td>172.20.101.10</td>
<td>G1-Ucsl_B07-R</td>
</tr>
<tr>
<td>Permit1</td>
<td>UDH</td>
<td>172.20.102.107</td>
<td>Permit1-R</td>
</tr>
<tr>
<td>Permit1</td>
<td>UDH</td>
<td>172.20.102.108</td>
<td>Permit1-S</td>
</tr>
<tr>
<td>Permit1</td>
<td>UDH</td>
<td>172.20.102.109</td>
<td>Permit1-T</td>
</tr>
</tbody>
</table>

Example System IP Address Information Report

System IP Address Report Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>System component name</td>
</tr>
<tr>
<td>Network Name</td>
<td>Network name for network adapter</td>
</tr>
<tr>
<td>Address</td>
<td>IP address for network adapter</td>
</tr>
<tr>
<td>Host Name</td>
<td>Name configured for network adapter</td>
</tr>
</tbody>
</table>
7.4 Options Menu

➢ To display features and documentation that may not be translated

From the WorkstationST Status Monitor Options menu, select Enable Non-Translated Content.

Note For additional information, refer to the section Multi-language Support.

7.5 Start and Stop WorkstationST Features

➢ To start or stop WorkstationST features

1. From the taskbar notification area, double-click the Status Monitor icon.

2. Right-click the desired feature and click Start or Stop from the Status Monitor shortcut menu.

Start and stop requests are sent to the WorkstationST Service. When the WorkstationST Service starts, it attempts to start all configured features, and to keep the features running. If a feature is stopped from the Status Monitor, WorkstationST Service will not attempt to restart it. If the feature is started again from the Status Monitor (or WorkstationST Service is restarted), the feature starts again.
7.6 Status Monitor Shortcut Menu

Shortcut menu options include:

- Start Selected Feature(s)
- Stop Selected Feature(s)
- View Additional Status Detail
- View OPC UA Connection Information
- View NTP (Time Sync) Detail
- Copy Selected
- Advanced

*Note* If the *Selected sub features to start* dialog box displays, select the sub features and click OK.

7.6.1 View Additional Status Detail Option

➢➢➢ To display additional status information: double-click the tray icon. Right-click the **Feature** and select **View Additional Status Detail**.

Information displays for the selected feature

The WorkstationST Service runs a System Data Interface (SDI) server. The Status Monitor uses an SDI client to obtain the information displayed. Information is not available when the WorkstationST Service is not running.

With the release of the ControlST V04.00, two new features have been added to the OPC DA server's additional status dialog box: Display Live Values and Display Connection Information. These features are available from the toolbar.

The OPC DA server provides live data to OPC DA and SDI clients and consumes data from various live data sources.
When the Alarm Server is selected from the WorkstationST Status Monitor, the server status displays. Select the **Configuration** tab to display the **Alarm Server Configuration** status.

![Alarm Server Status Viewer](image)

**Alarm Server Configuration**

<table>
<thead>
<tr>
<th>Category</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CIMPLICITY Alarm Manager(CAM) Interface</strong></td>
<td></td>
</tr>
<tr>
<td>Send Alarms To CIMPLICITY</td>
<td>False</td>
</tr>
<tr>
<td><strong>Legacy Alarm Support</strong></td>
<td></td>
</tr>
<tr>
<td>Connect To Legacy Alarm System (TCI)</td>
<td>False</td>
</tr>
<tr>
<td><strong>Mark V Alarm Interface</strong></td>
<td></td>
</tr>
<tr>
<td>Disabled (No Mark V Devices Consumed by this Workstation)</td>
<td></td>
</tr>
<tr>
<td><strong>Disk</strong></td>
<td></td>
</tr>
<tr>
<td>Disk Cleanup Enabled</td>
<td>True</td>
</tr>
<tr>
<td>Historical File Age</td>
<td>30 Days</td>
</tr>
<tr>
<td>Minimum Free Space</td>
<td>10 megabytes</td>
</tr>
<tr>
<td>Maximum Alarm Historical Disk Space Detection</td>
<td>Disabled</td>
</tr>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td>Automatically Reset Acknowledged Alarms</td>
<td>False</td>
</tr>
<tr>
<td>Emulate CIMPLICITY Event and SOE Behavior</td>
<td>False</td>
</tr>
<tr>
<td><strong>Historical</strong></td>
<td></td>
</tr>
<tr>
<td>Historical Alarm Path</td>
<td>C:\GEWorkstation\ST\HistoricalAlarmData</td>
</tr>
<tr>
<td>Historical D03 Alarms</td>
<td>Enabled = False</td>
</tr>
<tr>
<td>Historical Workstation</td>
<td>Alarms Enabled = True</td>
</tr>
<tr>
<td>Historical Workstation Text Alarms</td>
<td>Enabled = False</td>
</tr>
<tr>
<td><strong>Printing</strong></td>
<td></td>
</tr>
<tr>
<td>Alarm Printer</td>
<td></td>
</tr>
<tr>
<td>Alarm Printing Enabled</td>
<td>False</td>
</tr>
<tr>
<td>Print Queue Limit</td>
<td>0</td>
</tr>
<tr>
<td><strong>Alarm Scanner</strong></td>
<td></td>
</tr>
<tr>
<td>Alarm Scanner Enabled</td>
<td>True</td>
</tr>
<tr>
<td>Scan Rate</td>
<td>500</td>
</tr>
<tr>
<td><strong>Fault Code Scanner</strong></td>
<td></td>
</tr>
<tr>
<td>Fault Code Scanner Enabled</td>
<td>False</td>
</tr>
<tr>
<td>Scan Rate</td>
<td>500</td>
</tr>
<tr>
<td><strong>Network Monitor/Control System Health Alarms</strong></td>
<td></td>
</tr>
<tr>
<td>Connection Type</td>
<td>None</td>
</tr>
<tr>
<td>Connection Hostname or IP Address</td>
<td>127.0.0.1</td>
</tr>
<tr>
<td><strong>Consumed Devices</strong></td>
<td></td>
</tr>
<tr>
<td>GT-USCA</td>
<td>&quot;MarkVie&quot;&lt;GeneralPurpose&gt;</td>
</tr>
</tbody>
</table>
Select the **Alarm Sources** tab to display the connections and their status.

Select the **CAM Connections** tab to display the **CIMPLICITY Alarm Manager (CAM) Connections** status.

Select the **Client Connections** tab to display the **Alarm Event Clients** status.
Select the **Alarm Queues** tab to display alarm queue information from the Alarm Server.

Click any elipsis button to display information for the selected queue.

---

**Alarm Status Viewer File Menu Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Server Hostname</td>
<td>Hostname on the local computer (default) that has the Alarm Server enabled</td>
</tr>
<tr>
<td>Save Status to Text File</td>
<td>Allows user to save the current Alarm Server status to a text file</td>
</tr>
</tbody>
</table>
7.6.2 View OPC UA Connection Information Option

This menu option displays the OPC UA connection information for the selected feature.
7.6.3 View NTP (Time Sync) Detail Option

This option displays time synchronization information and is accessible when any feature in the status monitor list is selected.

Place the cursor over the column data to display a Tooltip for that data.

NTP Status Viewer File Menu Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify Remote Host</td>
<td>Allows user to display NTP service status on a remote computer (the local computer is the default display)</td>
</tr>
<tr>
<td>Data Logging</td>
<td>Allows user to log the Status Viewer’s data to a log file</td>
</tr>
</tbody>
</table>

Data Logging

Enable data logging to the file specified below.

C:\NtpStatus\viewLog.txt

OK Cancel

7.6.4 Copy Selected Option

This menu option allows you to copy the selected WorkstationST Status Viewer list to the clipboard for future use.
## 7.6.5 Advanced Option

### Advanced Menu Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Detail Log</td>
<td>Allows user to display detailed events for the selected feature</td>
</tr>
<tr>
<td>Save and Zip all feature logs</td>
<td>Allows user to save configured log files to a specified zip archive</td>
</tr>
</tbody>
</table>

### View Detail Log

![Log File](image)

**Debug Log Entries**

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Subscription</th>
<th>Keep Alive Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>2013-03-06</td>
<td>03:24:11.030</td>
<td>GeCSS Runtime.Workstation.CshVariableLiveDataFetcher</td>
<td>2</td>
</tr>
<tr>
<td>2013-03-06</td>
<td>03:24:51.052</td>
<td>GeCSS Runtime.Workstation.CshVariableLiveDataFetcher</td>
<td>2</td>
</tr>
<tr>
<td>2013-03-06</td>
<td>03:26:11.103</td>
<td>GeCSS Runtime.Workstation.CshVariableLiveDataFetcher</td>
<td>2</td>
</tr>
<tr>
<td>2013-03-06</td>
<td>03:26:51.125</td>
<td>GeCSS Runtime.Workstation.CshVariableLiveDataFetcher</td>
<td>2</td>
</tr>
</tbody>
</table>
7.7 Right-click Menu

➢ To display the right-click menu options: from the taskbar notification area, right-click the Status Monitor icon.

### Right-click Menu Options

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Privileges Log On</td>
<td>Replace the current user or temporarily override the current user</td>
</tr>
<tr>
<td>Privileges Log Off</td>
<td>Log off the current user</td>
</tr>
<tr>
<td>Show Current Privileges User</td>
<td>display the current user and their assigned privileges</td>
</tr>
<tr>
<td>User Preferences</td>
<td>Provides two options:</td>
</tr>
<tr>
<td></td>
<td>• Use Second Language displays the Status Monitor in the designated second language.</td>
</tr>
<tr>
<td></td>
<td>• Select Active Measurement System (Metric) to select the measurement system used by operator facing features such as Trender (the measurement system currently in use displays in parentheses).</td>
</tr>
<tr>
<td>Open Detail View</td>
<td>Displays the WorkstationST Status Monitor: Feature Status screen.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exit the Status Monitor (the tray icon no longer displays)</td>
</tr>
</tbody>
</table>

**Note** Privileges are modified from the System Information Editor only.

For more information, refer to the following documentation:

- WorkstationST/CIMPLICITY Advanced Viewer Integration Instruction Guide (GEI-100697), the section Privileges.
- ControlST Software Suite How-to Guides (GEH-6808), the chapters How to configure a Second Language for ControlST HMI Applications and How to Define a Measurement System for Use by ControlST HMI Applications.
8  On Site Monitor

The On Site Monitor (OSM) feature supports the Universal On Site Monitor (UOSM). The UOSM is a stand-alone computer that serves as a gateway to the customer’s system data, which is used by GE’s Maintenance and Diagnostic (M&D) group to detect and diagnose system problems.

The OSM collects system configuration data from the WorkstationST Config Reader and writes data files for the UPC (Universal Product Code), which communicates with the M&D group. The OSM provides realtime data using the OPC DA server. It displays in the Component Editor of the WorkstationST component.

Note: The OPC Server feature must be set to True before the OSM can be enabled.

The OSM should only be enabled on a UOSM computer.

➢➢➢ To enable OSM: from the WorkstationST Component Editor General tab Tree View, select Features, and set On Site Monitor to True
9 Linux WorkstationST

Starting with ControlST release V07.08.00C, a subset of WorkstationST features are able to be run in Linux. The following table shows what features are supported as well as any caveats.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Supported in Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Viewer</td>
<td>No</td>
</tr>
<tr>
<td>Alarm Server</td>
<td>Yes, Except OPC AE Alarm Consumption</td>
</tr>
<tr>
<td>AM Gateway</td>
<td>No</td>
</tr>
<tr>
<td>Control System Health (CSH)</td>
<td>No, but CSH running on a Windows PC can get PC Health and NTP info from a Linux Workstation</td>
</tr>
<tr>
<td>Device Manager Gateway</td>
<td>No</td>
</tr>
<tr>
<td>EGD Configuration Server</td>
<td>Yes</td>
</tr>
<tr>
<td>GSM</td>
<td>Yes</td>
</tr>
<tr>
<td>Historian</td>
<td>No</td>
</tr>
<tr>
<td>HMI</td>
<td>No</td>
</tr>
<tr>
<td>Modbus</td>
<td>Yes</td>
</tr>
<tr>
<td>Network Monitor</td>
<td>No</td>
</tr>
<tr>
<td>Network Time Protocol (NTP)/TSS</td>
<td>Not TSS, Instead use NTP for Linux</td>
</tr>
<tr>
<td>On Site Monitor (OSM)</td>
<td>No</td>
</tr>
<tr>
<td>OPC AE Server</td>
<td>No</td>
</tr>
<tr>
<td>OPC DA Server</td>
<td>No</td>
</tr>
<tr>
<td>OPC UA Server</td>
<td>Yes, but not data from a Mark V</td>
</tr>
<tr>
<td>Recorder</td>
<td>Yes</td>
</tr>
<tr>
<td>WorkstationST Service</td>
<td>Yes</td>
</tr>
</tbody>
</table>

9.1 Installation

The files needed to support a Linux Workstation are deployed on the ControlST DVD in the _files/linux sub-directory. Follow the instructions in the *WorkstationSTLinuxReadMe.txt* file to install the Linux version of WorkstationST.

9.2 Directories

The following table shows the default directories for finding various WorkstationST files.

<table>
<thead>
<tr>
<th>Type of file</th>
<th>Windows location</th>
<th>Linux location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Downloaded WorkstationST configuration files</td>
<td>C:\Config\Download</td>
<td>/usr/share/GEWorkstationSTConfig/Download</td>
</tr>
<tr>
<td>EGD Configuration Server</td>
<td>C:\Config\EgdCfgServerRepository\Pending</td>
<td>/usr/share/GEWorkstationSTConfig/EgdCfgServer-Repository/Pending</td>
</tr>
<tr>
<td>Historical Alarm Files</td>
<td>C:\GEWorkstationST\HistoricalAlarmData</td>
<td>/usr/share/GEWorkstationST/HistoricalAlarmData</td>
</tr>
<tr>
<td>OPC UA Certificates</td>
<td>C:\ProgramData\ControlST\OpcUa\Trusted\certs</td>
<td>/usr/share/GEControlST\OpcUa\Trusted\certs</td>
</tr>
<tr>
<td>Recorder Files</td>
<td>C:\GEWorkstationST\RecorderData</td>
<td>/usr/share/GEWorkstationST/RecorderData</td>
</tr>
<tr>
<td>WorkstationST log files</td>
<td>C:\ProgramData\GE Energy\WorkstationST</td>
<td>/usr/share/GE Energy/WorkstationST</td>
</tr>
</tbody>
</table>
9.3 Application Settings

WorkstationST Features have various Application settings like changing the Trace level for the Application Log. In Windows, these settings are found in a configuration file per Application (for example `C:\Program Files (x86)\GE Energy\WorkstationST Features\GeCssOpcUAServer.exe.config`). Because these configuration files are in the Product Installation sub-directory, changes made to them remain until a different version of the product is installed or else the changes are removed. Conversely, in Linux the Application settings are in each Applications pcode file (for example `/usr/share/GEWorkstationSTConfig/OpcUaServerConfigPcode.xml`). Because these settings are in the pcode files, changes are lost the next time the Workstation is downloaded.

9.4 OPC UA Certificates

In Windows, the OPC UA Certificates can be managed using the Certificate Manager that is launched from the Tools menu in WorkstationST Status Monitor. In Linux, use your preferred utility to securely copy certificates to `/usr/share/GECcontrolSTOpcUa/Trusted/certs`. Note that if a client tries to connect before their certificate is placed in the Trusted sub-directory then its certificate may be put into `/usr/share/GECcontrolSTOpcUa/Rejected/certs`. If the client should be permitted, move the certificate from the Rejected sub-directory to the Trusted sub-directory.

9.5 NTP Setup Instructions

In Windows, the Time Synchronization System feature handles Time Syncing the Workstation. In Linux, the standard NTP should be used.

➢➢ To specify IP and hostname of the NTP server in the hosts file (Optional): Edit `/etc/hosts` and add line `<IP address of your time source> NTP-server-host`.

➢➢ To manually check your connection configuration with the NTP-server (Optional): Execute the following commands:

• `sudo apt-get install ntpdate`
• `sudo ntpdate NTP-server-host`

➢➢ To set up NTP

1. Execute the following commands:
   • `sudo timedatectl set-ntp off`
   • `sudo apt-get install ntp`

2. Edit `/etc/ntp.conf` and add the following lines:
   • `server NTP-server-host prefer iburst`
   • `restrict 172.20.0.0 mask 255.255.0.0 nomodify notrap nopeer`

   **Note** Use the IP Address of your time source if you did not add it to your hosts file.

The restrict line allows applications like CSH and NTP Status Viewer running on PCs on the 172.20.0.0 network to get NTP status.

3. Execute the following command: `sudo service ntp restart`
9.6 WorkstationST Linux Command Line Status

In the Linux install, a command line version of the WorkstationST status monitor is provided. The command `wkstat` without command line arguments will provide command line help.

Options include:

- Showing feature status
- Showing feature additional status
- Stopping and starting a feature
- Importing and viewing the service certificate used for SDI communication to a controller in secure mode
- Showing the status of configured WorkstationST scheduled tasks
- Showing alarm server configuration, alarm source status, client connection information and summary information
10 Glossary of Terms

**Bind**  To establish the correspondence between the data in an exchange and variables in a device.

**Bind/Build**  To bind the configuration for each consumed exchange and create/update the configuration for any produced exchange.

**Collection**  More formally, an EGD Collection. A group of devices that constitutes a formal subset of the devices participating in a particular EGD installation. This arbitrary grouping allows users to subdivide the system to make some tasks easier.

**Consume**  To receive an EGD data message (exchange).

**Consumer**  An EGD node configured to receive an EGD data message.

**EGD**  A control network and communication protocol; a mechanism that provides access to global data between nodes supporting the EGD protocol.

**Exchange**  An EGD data message consisting of a header and a body of data. The header contains the producer ID and the exchange ID that uniquely identifies the message. The body of data is a block of bytes in a format agreed upon by the producer and all consumers.

**Feature**  An element of the WorkstationST runtime system, which can be optionally enabled through the ToolboxST application. Examples include OPC server, Recorder, and Alarm Viewer.

**Global Data**  A concept in which multiple controllers on a network can share information by exchanging portions of their local memory with peer controllers.

**OPC**  A standard for data exchange in the industrial environment. The OPC foundation provides specifications for various OPC standards such as OPC DA (Data Access) and OPC AE (Alarm and Event).

**Produce**  To send an EGD data message (exchange).

**Producer**  The EGD node configured to send data messages. The source of the data samples for an exchange.

**Refresh**  To bind the configuration for each consumed exchange for a particular consumed device.

**Runtime**  Software stored in the controller’s Flash memory that converts application code (pcode) to executable code.

**Unbound Variables**  Variables required by a consumer that were not found in the producer configuration during the bind.